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Conventions

The following conventions are used in this manual:

» The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a note, which alerts you to important information.

bold Bold text denotes items that you must select or click on in the software,
such as menu items and dialog box options. Bold text also denotes
parameter names.

italic Italic text denotes variables, emphasis, a cross reference, or an introduction
to a key concept. This font also denotes text that is a placeholder for a word
or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames and extensions, and code excerpts.
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1
Introduction

When you install the LabVIEW Datalogging and Supervisory Control
module, the DSC Server Development palette is added to the Functions
palette, as shown in the following figure. This palette contains the Server
Interface VIs and Server Registration VIs. A DSC Server Data Types
palette also is added to your Controls palette.

Figure 1-1. The VI Server Kit Palette

You can find sample servers, sample server registration VIs, and sample
server configuration utility VIs in the
labview\examples\lvdsc\servers\ directory to help you get started.
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VI-Based Server Development Tools
The LabVIEW Datalogging and Supervisory Control module includes
several VI-based examples with which you can become familiar with
developing servers. The server development tools also contain the example
VIs referenced in Chapter 3, Function Reference.

You can use the Server Browser utility to interactively view the devices,
items, and capabilities registered by a server. With this utility, you can
launch a server configuration utility (if available) or, from the Tag Engine,
display the front panel of a server while it is running. Select
Tools»Datalogging and Supervisory Control»Advanced» Server
Browser.

Because you cannot debug a server while it is running in the Tag Engine,
use the Interactive Server Tester instead. This tool emulates the Tag
Engine/Server Interface in LabVIEW. With this tool, you also can test
launching, error reporting, and reading and writing server data in a full G
development system environment. Select Tools»Datalogging and
Supervisory Control»Advanced»Interactive Server Tester. For more
information about its operation, use the Help window (<Ctrl-H>) when you
run this utility.

Why Develop VI-Based Servers?
VI-based servers allow you to use your G programming skills to complete
simple, yet specific tasks. VI-based servers also provide a means of using
existing G-based applications as servers and simulating hardware or actual
systems.

The Tag Engine can interface with any server that uses the Tag Engine
Server interface. While the server does not need to be implemented in G, it
must use G to interface with the Tag Engine using the Tag Engine Server
Interface VIs.

Note Three cases exist in which you do not use G to interface with the Tag Engine. If a
server is written as a DLL to the National Instruments Industrial Automation Device Server
Specification (IA Device Server), the Tag Engine can interface to it through the IAIO
Server Proxy. Also, if a server is implemented as a Windows DDE server or an OPC server,
the Tag Engine can interface to it directly.



Chapter 1 Introduction

© National Instruments Corporation 1-3 VI-Based Server Development Toolkit Reference Manual

How Do VI-Based Servers Work?
VI-based servers supply data points from several input items to the Tag
Engine as these points are read. The Tag Engine also can send values for
output items.

The Tag Engine accepts numeric (double precision) values and string data
from servers. Double values can be analog, discrete (Boolean), or bit array
(bit vectors up to 32 bits in length), depending on your tag configuration for
a specific device item. String data is a packed array of unsigned 8-bit
integers. All scalars must be converted to double precision floating-point
values to pass to the Tag Engine. The server converts correctly signed or
unsigned values to double floating-point representations.

Ideally, the server timestamps values as they are acquired from items,
recording the time at which the value was acquired or sampled. The
timestamp is in seconds since January, 1904, (Universal time) and is a
double precision floating-point number rather than an unsigned 32-bit
integer. Therefore, resolution is less than 1 second. If the server cannot
timestamp the values as they are acquired, the server can instruct the Tag
Engine to timestamp the value when it is received.

Overview of the Server Development Process
The server development process involves several steps, discussed in the
following sections. Samples for this toolkit are installed in the folder
labview\examples\lvdsc\servers\.

Create the Server
Build a server using the Server Interface VIs. See the Server Operation
section of Chapter 2, VI-Based Server Interface to the Tag Engine for
information regarding the architecture of a server and which VIs to use.
This toolkit includes a server named dmy_srvr.vi in the Sample folder.
In addition to this sample server, several of the VI-based servers shipped
with the LabVIEW Datalogging and Supervisory Control module, such as
the SIM Server, are in source code form.
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Register the Server
In order for the LabVIEW Datalogging and Supervisory Control module to
launch a VI-based server and allow a user to configure tags that use the
server, you must register the server. See the Server Registration section of
Chapter 2, VI-Based Server Interface to the Tag Engine, for information on
the VIs to use to register a server. This toolkit includes a server registration
example named Register Dummy Server.vi in the Sample folder.

Debug the Server
This toolkit provides a utility called the Interactive Server Tester utility
with which you load and run a server in LabVIEW, allowing you to debug
the server while it is running. See the Debugging and Testing Your Server
section of Chapter 2, VI-Based Server Interface to the Tag Engine, for
more information.

View the Server Running in the Tag Engine (Optional)
When the server is running in the Tag Engine, you cannot debug it or view
its diagram, but you can view the server front panel while it is running.

Press the Server Browser button on the Engine Manager front panel to
launch the Server Browser utility. Select your server in the server list—it
shows with a diamond symbol next to the server name if the server is
loaded, and the diamond is black if the server is running. Select your server
and press the Show Server User Interface button to open the server and
show the front panel while it is running. By adding indicators to the server
front panel, you can monitor server operation while it is running in the
engine.

Create a Server Configuration Utility (Optional)
Depending on the complexity of the server, you might choose to provide
a server configuration utility rather than just a server registration VI.
Relevant server configuration information can be stored in a file and
retrieved by the server at run time. This configuration utility then also
registers the server information. This toolkit includes a server configuration
example called srvr_cfg.llb available in the Sample directory.



© National Instruments Corporation 2-1 VI-Based Server Development Toolkit Reference Manual

2
VI-Based Server Interface
to the Tag Engine

This chapter describes VI-based server configuration and registration,
server operation, and error handling and performance issues you might
encounter. This chapter concludes with a VI-based server design example.

Server Configuration
Generally, a server has a configuration utility associated with it that allows
you to complete the following tasks:

• Set up communication parameters

• Specify error handling

• Configure hardware

• Configure poll rates

• Define a set of valid device and item names

The user executes this utility before using the Tag Configuration Editor to
configure any tags using the server and before the Tag Engine executes the
server.

During configuration, the server must register information about itself and
the devices and items it manages. Although servers are not required to have
configuration utilities, they must be registered before the LabVIEW
Datalogging and Supervisory Control module can use them.

See the Srvr_cfg.llb example in the
examples\lvdsc\servers\Sample directory for an example server
configuration utility.
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Server Registration
The LabVIEW Datalogging and Supervisory Control module uses the
Common Configuration Database (CCDB) file to locate present servers
and retrieve details about those servers, such as paths, registered devices,
and registered items.

This database maintains tables of servers, devices, and items. Register
information about your server as part of your server configuration utility.
If you lack a configuration utility for your server, you must provide a VI
that performs the registration.

The server uses a set of subVIs to configuration data in the configuration
database. These subVIs are contained in the DSC Server Registration
palette shown in the following figure.

Figure 2-1. DSC Server Registration Palette

To register your server, use the SVRG Add Server Row VI, which creates
an entry for your server in the Servers table of the CCDB. When you
register your server using the SVRG Add Server Row VI, it appears in the
list of servers accessible from the Tag Configuration Editor server list with
the name supplied in Server Name. To use your server from the LabVIEW
Datalogging and Supervisory Control module, you must register the
following information:

• Server Name—Server Name is the same name as that used by
the server in the block diagram when using the Server Interface
(SRVR) VIs.

• Server Launch Path to VI.
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Additional information a server can register includes the following:

• Predefined device names

• Predefined item names

• For each item name, item information:

– item data type (see Table 3-1, Item Data Types)

– allowed item directions (access rights): input, output, I/O
(required)

– item range max and min (optional)

– item unit (optional)

– item max length (optional)

You might want to register one or more devices recognized by your server
or configured as part of your server configuration. Use the SVRG Add
Device Row VI to register a device for your server. This VI creates an entry
for your device in the Devices table of the CCDB. You are not required to
register a device if your server can interpret device strings to identify the
device; however, doing so makes it easier for the user to select a device.

When you register one or more devices for a server, the device name
appears in the device list when you select that server in the Tag
Configuration Editor. Even if you do not have a specific device or all items
of interest are associated with a single device, you must register the device
if you plan to register any items. In this case, use a default device name such
as ALL.

You also might want to register one or more items recognized by your
server for a specific device or configured as part of your server device
configuration. Use the SVRG Add Item Row VI to register an item for your
server device. You must register a device before you can register an item for
that device. This VI creates an entry for your item in the Items table of the
CCDB. You are not required to register an item if your server can interpret
item strings to identify the device item; however, doing so makes it easier
for the user to select an item. When you register one or more items for a
server device, the item name appears in the Item list when that server and
device are selected in the Tag Configuration Editor.

Registering engineering unit information is optional and should be done
only if the actual engineering range and unit information for the item can
be predetermined. If you do not register engineering unit information, the
user can enter the information when creating tags in the Tag Configuration
Editor.
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Use the SVRG Delete Row VI to delete a specific row from the Server,
Device, or Item tables. If you delete a server from the Server table, all
devices for that server in the Device table and all items for that server in the
Items table are deleted automatically. You do not need to delete devices and
items individually if you want to delete them all. Similarly, if a device is
deleted from the Devices table, all items for that device in the Items table
are deleted automatically.

The following VIs query information once it is registered in the CCDB:

• SVRG Get Server Row.vi

• SVRG Get Device Row.vi

• SVRG Get Item Row.vi

You can use these VIs if you save information in the CCDB that is useful
for your server at launch time. You also can use them to see whether your
information is registered successfully.

Register Server Example
The Register Dummy Server VI, shown in Figure 2-2, illustrates how to
register information for your server. The user can configure server
behavior, devices, or server communications channels with the
configuration utility. Registering server, device, and item information is
part of server configuration. If you develop a VI-based configuration
utility, include the server registration as part of it. You might not develop a
server configuration utility in other cases, such as a simple device or fixed
server configuration or if you are writing a server to simulate tags. In these
cases, you must develop a VI similar to the Register Dummy Server VI in
Figure 2-2 and register the items for which your server generates or accepts
data. The examples\lvdsc\servers\Sample folder includes this VI
and a more complete server configuration utility VI example. Most of the
simulation server examples for the LabVIEW Datalogging and
Supervisory Control module have a register server VI similar to the one
shown in Figure 2-2.
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In Figure 2-2, the VI that registers the server first deletes the existing server
registration information from the CCDB by calling the SVRG Delete Row
VI with the following information:

• Server Name (Dummy Server)

• Delete What input set to 2 (server)

Figure 2-2. Register Dummy Server VI
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This action deletes any entry associated with the server name from each of
the Server, Device, and Item tables of the CCDB.

Next, the VI supplies new information to the Server, Device, and Item
tables by calling the SVRG Add Server Row VI, SVRG Add Device Row
VI, and SVRG Add Item Row VI, respectively. See Chapter 3, Function
Reference, of this manual for detailed descriptions of these VIs.

In Figure 2-2, the front panel controls of the Register Dummy Server VI
store the following as default values:

• Server Name (Dummy Server)

• Server VI Name (dmy_srvr.vi)

• Device Name (Dummy Device)

• Item Info (item names and parameters)

Although this example server only registers one device, it registers several
items for that device.

The example VI in Figure 2-2 calls the SVRG Add Server Row VI with the
following information:

• The server name (Dummy Server)

• The name of the VI file (dmy_srvr.vi) that implements the server

• The path to dmy_srvr.vi

• The server type set to VI

The path to the configuration utility is left unwired to indicate that no
configuration utility exists. Set server type to VI to notify the LabVIEW
Datalogging and Supervisory Control module that the server is a VI-based
server. The LabVIEW Datalogging and Supervisory Control module
launches the VI corresponding to that server when the server is selected by
a given tag configuration. The Register Dummy Server VI computes the
path to dmy_srvr.vi by obtaining the current VI path (current VI is
Register Dummy Server VI), removing the VI name, and appending
dmy_srvr.vi.

The VI can compute the path because both the Register Dummy Server VI
and dmy_srvr.vi are in the same file folder. This example VI leaves all
other inputs at their default values.
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The example VI in Figure 2-2 calls the SVRG Add Device Row VI once
with the following information:

• The unique device name (Dummy Device)

• The device address (Dummy Device)

• The device default rate, set at 0.1 seconds

• The server name associated with the device

You must register at least one device for a server if you plan to register any
items, because all items are associated with a specific device. If the server
does not handle any devices, choose a default device name such as ALL.
Leave all other inputs at their default values.

The Register Dummy Server VI also calls the SVRG Add Item Row VI for
each item registered for the Dummy Server. These items are saved in an
array of clusters on the front panel. For each item, this example VI registers
the following information:

• A unique item name

• An item data type

• A direction (input, output, or I/O)

This example VI also registers optional item information, including the
following parameters:

• item max range

• item min range

• item unit

• item max length

This example VI leaves all other inputs at their default values.
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Server Operation
The server uses a set of subVIs to communicate with the Tag Engine during
server execution. These are contained in the DSC Server Interface palette
shown in the following figure.

Figure 2-3. DSC Server Interface Palette

The servers are launched when the Tag Engine starts. Servers must execute
until the engine’s shutdown status becomes TRUE. The shutdown status is
returned by several of the server interface VIs.

During operation, the server uses the following VIs to communicate with
the Tag Engine and to read the status from the Tag Engine. See Chapter 3,
Function Reference, of this manual for detailed descriptions of these VIs.

• SRVR Get Item List VI—Returns lists of groups and items, item
characteristics, and refnums the Tag Engine uses.

• SRVR Write Input Queue VI—Writes input and I/O item data to the
Tag Engine. This VI also reports errors on specific input or output
items. You can set this VI to return status information specifying
whether the server is to shut down or if item changes are pending.

• SRVR Read Output Queue VI—Receives new output values for output
and I/O items from the Tag Engine. This VI also returns status
information specifying whether the server is to shut down or if item
changes are pending.

• SRVR Post Message VI—Writes error and non-error messages from
the server to the Tag Engine where the messages can be logged and
displayed to the end-user.

• SRVR Get Item Changes VI—Returns a list of group and item
changes.
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Server Initialization
When the Tag Engine launches a server, the server first must call the SRVR
Get Item List VI, passing in the server name it registered under. This VI
returns the list of items the Tag Engine uses from the server and details on
how to use the listed items. This VI also returns a list of groups that specify
timing information for the items. Information specified for each item
includes the following parameters:

• device name

• item name

• datatype

• item direction

• item datatype

• scan rate

• notify on change flag

• refnum (a signed 32-bit integer)

• group name

• access path

Information specified for each group includes the following parameters:

• group name

• scan rate

• deadband

• device name

Note The server must use the refnums when it passes item information to the Tag Engine
or receives information from it.

You can have multiple tags assigned to an item. The server updates all refnums associated
with that item. Although it is best to support this capability, if you cannot, send the can’t
support multiple connections to item status for duplicate items in the item list. Refer to
the Error Handling and the Status Parameter section of this chapter for more information.

Next, the server sorts through the item list. If any device or item names are
incorrect, not configured for the requested item direction, or not available
for some reason, the server writes the status information using the SRVR
Write Input Queue VI. The server can use the group list to determine the
timing configuration for each item. The scan rate and device name
information is already duplicated in the item list. One additional parameter,
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% deadband, is available only from the group list. A server can ignore the
group list if it does not implement % deadband.

Finally, the server polls all valid input or I/O items for their current readings
and writes those to the input queue. If there are problems with any items,
the appropriate status is written to the input queue.

Server Input and Output
The server must run continuously, usually executing two parallel loops: an
input polling loop and an output polling loop. Both loops must run until the
server is signaled to shut down. The server should configure timing for
input polling to match the scan rate requested in the item list or as close to
the specified scan rate as possible.

The server polls its inputs according to its polling configuration and writes
all new or changed input data to the input queue, along with timestamp and
status information. The SRVR Write Input Queue VI returns the number
actually written to the input queue, which notifies the server of any queue
overflow situations. Ideally, the queues allocated by the Tag Engine are
large enough to prevent overflow. By default, the server can instruct the
LabVIEW Datalogging and Supervisory Control module to block the
server and handle the rewrite. The server directly handles retries by clearing
the block if queue full input; however, the server also must check and
rewrite data as necessary, or the data is lost.

In addition to polling the item inputs, the server occasionally reads the
output queue to obtain item output values.

Wire the server name to the SRVR Read Output Queue VI, along with a
maximum number of values to read (max # to read = 0 reads all available
values for the server) and a maximum timeout period to wait before
reading the queue. The VI returns as soon as one of the following
events occurs:

• Information is available in the queue

• The server shutdown or changes pending status is TRUE

• A timeout occurs

To indicate any error status for those items to the Tag Engine, the server
must write the server input queue using the refnums corresponding to
output items to the input queue. If the item is used as an output, only the
value is ignored; however, the status is read, saved, and then reported.
The server must write to the input queue with the status of an output item
when that status changes. If a problem occurs when outputting to the item,
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the server must write to the input queue with the appropriate status. If the
status previously was bad but has become good, the server also must write
to the input queue with a good status value. Refer to the Error Handling
and the Status Parameter section of this chapter for more information.

Server Shutdown
When the engine stops, it sends shutdown notification to the servers.
Shutdown can be detected from the SRVR Write Input Queue VI,
SRVR Read Output Queue VI, and SRVR Get Status VI. The event-driven
SRVR Read Output Queue VI is a good place to wait for shutdown
notification because it returns immediately if the engine goes into
shutdown mode. You can use this mechanism even if the server has no
output items. You also can explicitly poll the server status occasionally
using the SRVR Get Status VI.

A server is given about 30 seconds to shut down by default. If the server has
not stopped execution by that time, the user is asked for permission to abort
(close) the server.

Server Changes
To obtain information about item changes for the server, the server
either acquires a completely new item list and group list by calling the
SRVR Get Item List VI or retrieves lists of exceptions by calling the SRVR
Get Item Changes VI. The SRVR Get Item Changes VI specifically lists
the items and groups that are obsolete, new, or have changed. Items with no
associated changes are not included in the outputs. Calling the SRVR Get
Item List VI or SRVR Get Item Changes VI resets the changes pending
status.

The server now sorts through the changed item and group lists. If any
device or item names are incorrect, not configured for the requested item
direction, or not used for some reason, the server must write the status
information using the SRVR Write Input Queue VI.
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Sample Server Design
The following figure shows the design of a simple server.

Figure 2-4. Sample VI-Based Server

Note This sample server works only with scalar data types, not strings.

Figure 2-4 demonstrates how the SRVR VIs are often used. The VIs that
poll inputs, update outputs, and sort items are server-specific subVIs.
The remaining VIs are part of the LabVIEW Datalogging and Supervisory
Control module server interface libraries.
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The server in Figure 2-4 is launched for the first time by the Tag Engine
when a tag configuration using the server is run. First, the server calls the
SRVR Get Item List VI, passing in the server name under which it is
registered (see the Server Registration section of this chapter for more
information). The server then receives a list of items from the Tag Engine
to poll, including the following elements:

• Item strings

• Device strings

• Polling rates

• Need for input, output, or both to be performed for the item

• Data type for the item

• Unique reference number the LabVIEW Datalogging and Supervisory
Control module uses to identify the item

This server only uses the item information and ignores the group output
SRVR Get Item List VI.

Because the LabVIEW Datalogging and Supervisory Control module uses
the unique reference number in all subsequent operations, you must
configure the server to set up internal lookup tables for converting reference
numbers and the server representation for each item. Sort out the items that
require inputs and those that require outputs, and initialize the server to
perform those functions for the requested items.

While initially sorting through the item list, the server checks for errors in
the item list, including the following errors:

• Unrecognized device

• Unrecognized item

• Unsupported direction

• Wrong data type for item

• Server cannot support multiple refnums for the item

For any of these conditions, the server writes the appropriate status
information to the server input queue for any item or device that is invalid
or unusable for any reason, and the LabVIEW Datalogging and
Supervisory Control module marks the bad status for those items in the
Real-Time Database.

If the error is considered severe, such as not being able to communicate
with a device, the server might post an error message to the Tag Engine.
These messages are displayed to the user.
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The server then sets up the following two (or more) loops:

• Input Loop—Regularly polls the requested input and I/O items from
one or more devices and writes the corresponding value, status, and
time stamp information to the server input queue.

• Output Loop—Waits on any output values for the server to be placed
in the server output queue from the LabVIEW Datalogging and
Supervisory Control module. If any values are read from the output
queue, the server writes these values to the output and I/O items.

Both the SRVR Read Output Queue VI and SRVR Write Input Queue VI
return shutdown and changes pending information for the server. For the
SRVR write input queue VI, pass in the server name and set the return
status input to TRUE for the status information to return. If you use the
output loop to monitor this condition, the input loop does not need to check
for the condition. In this case, the output loop must notify the input loop to
terminate when it detects shutdown. If the shutdown status is TRUE, the
server then completes execution as soon as possible. If the changes
pending output is TRUE, the server reads new item list or changed item
list information and adjusts the active items accordingly.

Error Handling and the Status Parameter
Status is an indication of the quality of the value passed to the
server—good, uncertain, or bad. The status parameter is stored in the
Real-Time Database along with the value and timestamp for each tag.
When status is less than zero, indicating bad status, the Tag Engine
assumes that the value for that item is not valid.

If a value is good or uncertain, LabVIEW updates the value, timestamp,
and status fields in the database with the new information, after scaling the
value as necessary. The LabVIEW Datalogging and Supervisory Control
module also computes alarms and performs historical logging on the value,
as was configured for the associated tag.

If a value is bad, LabVIEW updates the timestamp and status fields in the
database but retains the last value with a good or uncertain status.
LabVIEW does not compute alarm levels. Users can activate bad status
alarm notification on any tag as part of the tag configuration.

status is a 32-bit signed integer. The top 16 bits (MSW) must be set to one
of the status numbers listed in Table 2-1. The bottom 16 bits (LSW) are
used by the server, sometimes to pass server-specific status information;
otherwise, leave these bits set at 0. The server determines the appropriate
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status meaning and passes the corresponding MSW status value. The
server-specific information is passed to the LSW. The more specific the
status returned, the better; however, the server must indicate if the value is
good, uncertain, or bad.

Table 2-1. Status Reports

Quality

MSW
Status
Value Status Meaning Who Reports?

Good 0 No error—Value and timestamp is valid. Server

Warning—
Value Uncertain

50 Initial/Default Value. Tag Engine

60
Value out of range. The value is either out of
raw-range or out of the engineering unit range
during scaling.

Tag Engine

61
Value exceeded high range. The value exceeded
the high raw-range or engineering unit range
during scaling.

Tag Engine

62
Value exceeded low range. The value exceeded the
low raw-range or engineering unit range during
scaling.

Tag Engine

100 Uncertain Value. Server

105

Last known value (stale data)—Dev comm error.
There is a communication error or failure to
communicate with the device. This is the last
known valid reading for the item. The server must
pass a valid value to use this warning status.

Server

150 Item reading not accurate. Server

160 Item value out of range. Server

161 Item value exceeded high range. Server

162 Item value exceeded low range. Server

Error—
Value Bad

–1
User Level Error. Tag Engine

–2 Uninitialized Tag. Tag Engine

–3
Server Execution Error. The Tag Engine is unable
to find or launch the server.

Tag Engine or
Server
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The server must timestamp values even when reporting a bad status.

The server uses the SRVR Post Message VI to post human-readable events
and errors to the Tag Engine system message handler. Use this VI to report
catastrophic and general errors, such as losing communication with a
device, and the subsequent recovery from such errors. These messages are
displayed to the user and logged to a system log file, so be concise and
avoid sending excessive messages. As long as things are operating
correctly, no messages are necessary. Report these errors once during

–100 Bad Value. Server

–101
Unrecognized Device. The server does not
recognize the device name string for this item and
cannot acquire or output values.

Server

–102 Device offline/out-of-service. Server

–103

Device/Item Hardware Error (Hardware Bad).
Device and item names are valid, but the server is
unable to read or write items because of hardware
failure or a configuration error.

Server

–105

Device Communication Error—failure of
communications with device. The device might be
temporarily offline; however, the server is unable
to update a value for the item because of lost
communication.

Server

–111
Unrecognized Item. The server does not recognize
the item name string for this item and cannot
acquire or output values.

Server

–112
Unsupported read/write mode. Device and item
names are valid, but the server is unable to support
the requested read or write mode for the item.

Server

–113
Unsupported datatype. Device and item names are
valid, but the server is unable to support the
datatype for the item.

Server

–114 Unable to support multiple connections to item. Server

Table 2-1. Status Reports (Continued)

Quality

MSW
Status
Value Status Meaning Who Reports?
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start-up/initialization and on a per device basis. The server still must pass
the appropriate status for all requested items on the input queue. If an error
message is reported and the server later recovers from the error, the server
should send a non-error message notifying the user of the recovery.

Note Remember to be economical when sending messages. If you send messages
frequently, the system log file for the user fills up and the Tag Engine constantly prompts
the user.

Server-User Interface
The front panel of the server VI remains hidden from the user during VI
execution, but can be displayed using the Server Browser utility from the
Tag Engine. The server can display general server status or other
information on its front panel. The user sees this information only if the
front panel is open. Use VI Setup to hide the server toolbar and prevent the
user from closing or aborting the server while it is running.

Debugging and Testing Your Server

Testing Server Registration
You can use the Server Browser utility to view most of the information
registered by your server. To launch the Server Browser utility, select
Tools»Datalogging and Supervisory Controls»Advanced»Server
Browser. Select your server in the Servers list and press the View Server
Information button to view the device and item information that has been
registered by the server. If your server name does not appear in the list then
the server is not registered in the currently selected CCDB.

Testing Server Operation
The LabVIEW Datalogging and Supervisory Control module provides a
utility, the Interactive Server Tester that allows you to simulate the Tag
Engine and run your server in LabVIEW where you can use the G
environment debugging tools. You cannot properly test and debug your
server without using this tool as the DSC Server Interface VIs do not
execute correctly without either the Tag Engine or the Interactive Server
tester running.
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To launch the Interactive Server Tester, choose Tools»Datalogging and
Supervisory Control»Advanced»Interactive Server Tester.

Choose the server you want to test in the Server under test list box.
The Interactive Server Tester shows the path to the server and other server
information. You can then load the server item configuration for testing
the server either from the CCDB or from a tag configuration (.scf) file.
Press the Load Config from CCDB button to load all the server items that
are currently registered in the CCDB. Press the Load Config from .scf
button to select an .scf file that uses the server. When you select an .scf
file, only the server items used by that file are loaded.

Once the configuration is loaded, press the Launch Server button to launch
and load the server. Press the Monitor input queue button to bring up a
window that displays all items sent by the server to the LabVIEW
Datalogging and Supervisory Control module. Normally, you should press
this button as soon as you launch the server if your server sends a lot of
values to the LabVIEW Datalogging and Supervisory Control module,
otherwise the input queue may overflow. Press the Write output queue
button to bring up a window from which you can simulate writing item
values to your server. The Read input queue button brings up a display that
reads and displays all values currently in the input queue each time you
press the Read button. If the Monitor Input Queue display is shown, it
automatically reads all input values, so the Read Input Queue window may
return little information. Press the Flush input queue button to clear out
any values in the input queue.
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Once the server is open and running (the Interactive Server tester will load
and show the VI server top level VI if it is not already open), you can use
breakpoints and other debugging tools to monitor the server operation.
When you are finished, press the Shutdown Server button to signal the
server to stop execution. If your VI-based server operates correctly using
the Interactive Server Tester, it should operate correctly when loaded and
run by the Tag Engine.

Try using the SIM Server to familiarize yourself with the Interactive Server
Utility.

Viewing the Server While Running in the Engine Process
When the server is running in the engine process, you cannot debug the
server or view its diagram, but you can view the server front panel while it
is running. Press the Server Browser button on the Engine Manager front
panel to launch the Server Browser utility. Select your server in the server
list—it appears with a diamond symbol next to the server name if the server
is loaded, and the diamond is black if the server is running. Select your
server and press the Show Server User Interface button to open the server
and show the front panel while it is running. By adding indicators to the
server front panel, you can monitor server operation while it is running in
the engine. It is a good idea to minimize the amount of information
displayed by the server while it is running so as not to use too much CPU
bandwidth. You could use a user interface button on your server front panel
that only displays server information when pressed.

Load and run a tag configuration file that uses the SIM server and then open
the SIM server in the Engine Process to see how this works.
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3
Function Reference

This chapter describes the VIs that register VI-based servers and interface the VI-based
servers to the Tag Engine during server execution.

Server Registration VIs
The server uses a set of subVIs to communicate with the Tag Engine. These subVIs are
contained in the DSC Server Registration palette.
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SVRG Add Server Row VI
Registers your server for use with the LabVIEW Datalogging and Supervisory Control
module and creates an entry for your server in the Servers table of the CCDB.

server name is the unique name of the server as it should appear in the
Server list in the Tag Configuration Editor and other utilities. This is the
same name you use in your server VI when calling the SRVR VIs to retrieve
information. You must wire a non-empty string for the server name and,
when possible, use an understandable name. Spaces are permitted in the
name, and the maximum length of the string cannot exceed 255 characters.

can add devices (optional) is set to FALSE, by default. Set this bit to TRUE
if your server is capable of interpreting device strings and can accept a new
device name at server launch time. When set to TRUE, users can create new
device names in the Device list for the server. If your server can access only
preregistered or predefined devices, you must set this input to FALSE or
leave it unwired.

server type is the type of the server. You must identify your VI-based
servers as such by setting the server type string to VI. The LabVIEW
Datalogging and Supervisory Control module then interprets your
execution path as a VI path.

launch path is the path to the VI implementing the server, including the VI
name. The LabVIEW Datalogging and Supervisory Control module locates
the path and VI name from the server name to dynamically load your
server VI.

Note The VI name is independent of the server name.

error in (no error) describes the error status before this VI executes.

configuration path (optional) is the path to the configuration utility.
If there is no configuration utility, leave this input unwired.

error out describes the error status after this VI executes.
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SVRG Add Device Row VI
Registers a device for your server with the LabVIEW Datalogging and Supervisory Control
module and creates an entry for your device in the Devices table of the CCDB. When you
register one or more devices for a server, the device name appears in the Devices list when
your server is selected in the Tag Configuration Editor. Even if you do not have a specific
device or all items of interest are associated with a single device, you must register the device
if you plan to register any items. In this case, use a default device name, such as ALL. You can
use device name as a way to logically group the items in your server.

dynamically configurable (optional) is set to TRUE if device values such
as default rate can be dynamically reconfigured while running the server.
By default, this input is FALSE.

device type (optional) is a string documenting the type of device. This
input is for documentation purposes only and might be useful for your
server. This field is not used by the LabVIEW Datalogging and Supervisory
Control module.

device name is the name of the device as it should appear in the Devices
list in the Tag Configuration Editor and other utilities. Each device
registered for your server must have a unique name. Spaces are permitted
in the name, and the maximum length of the string cannot exceed 255
characters.

can add items (optional) is set to FALSE, by default. Set this bit to TRUE if
your server is capable of interpreting device strings and can accept a new
device name at server launch time. When set to TRUE, users can enter new
device names in the Devices list for the server. If your server can access
only preregistered or predefined devices, you must set this input to FALSE

or leave it unwired.

error in (no error) describes the error status before this VI executes.
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default rate (optional) is the default sampling period, in seconds, for
polling the item.

device address (optional) is an input that you can use to record device
address information stored for this device by your server. The LabVIEW
Datalogging and Supervisory Control module does not interpret this
information.

server name is the name of the server associated with this device. Use
the same server name you used to register the server. You must wire a
non-empty string for server name.

error out describes the error status after this VI executes.
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SVRG Add Item Row VI
Registers an item for your server device with the LabVIEW Datalogging and Supervisory
Control module. You must register a device before you can register an item for that device.
This VI creates an entry for your item in the Items table of the CCDB.

server name is the name of the server for which this item is registered.

device name is the name of the device for which this item is registered.

add max length is FALSE, by default, and no maximum length value is
registered for the item. If you registered a maximum length value, set this
input to TRUE.

item max length is the maximum length associated with this item. It is
interpreted as the maximum number of bytes in the item for string types
(item data type = BLOB or STR) or the maximum number of bits for bit
array types (item data type = BITA). If you register the maximum length
for the item, you also must set the add max length input to TRUE;
otherwise, the information is not stored in the item row. For all other data
types, if item max length is greater than 1, the LabVIEW Datalogging and
Supervisory Control module interprets it as an array of values and allows
the user to configure the item as a string tag.

With the following three inputs— item unit, item min range, and item max range—
you can register engineering unit information for the item. If you register engineering unit
information, the LabVIEW Datalogging and Supervisory Control module automatically
imports the information into the tag configuration when the item is selected, which can be
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a convenient way of passing configuration information from the server to the LabVIEW
Datalogging and Supervisory Control module if the server holds the information. Users still
can modify the information. Registering engineering unit information is optional, and you
should only register this information if you can predetermine the actual engineering range and
unit information for the item.

item unit (optional) is the engineering unit string for this item. If you
register the engineering unit for the item, you also must set the add unit
input to TRUE; otherwise, the information is not stored in the item row.

item min range (optional) is the minimum value in engineering units for
this item. If you register the engineering minimum range for the item, you
also must set the add min range input to TRUE; otherwise, the information
is not stored in the item row.

item max range (optional) is the maximum value in engineering units for
this item. If you register the engineering maximum range for the item, you
also must set the add max range input to TRUE; otherwise, the information
is not stored in the item row.

default rate (optional) is the default sampling period, in seconds, for
polling the item.

item name is the name of the item as it appears in the Items list in the Tag
Configuration Editor and other utilities. Each item registered for a device
must have a unique name. Spaces are permitted in the name, and the
maximum length of the string cannot exceed 255 characters.

item address (optional) is an input that you can use to record item address
information stored for this device by your server. The LabVIEW
Datalogging and Supervisory Control module does not interpret this
information.

item data type is a string input indicating the item data type, such as
Double, Boolean, or Integer. This parameter is used to predict the type of
tag associated with an item when the Tag Configuration Editor
auto-generates a tag configuration file, as shown in Table 3-1, Item Data
Types. Users can select any scalar (not STR or BLOB) type for any of the
tag types—analog, discrete, or bit array—which are internally represented
as double floating-point values.
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Note The ultimate datatypes used are BLOB (item data type = BLOB or STR) or DBL for
all items. LabVIEW uses this field to prevent the user from selecting an item with item data
type = BLOB or STR when configuring an analog, discrete, or bit array tag. LabVIEW also
uses this field to prevent the user from selecting an item with item data type ≠ BLOB or
STR when configuring a string tag. The LabVIEW Datalogging and Supervisory Control
module treats items with item max length greater than 1, excluding BITA, as string tags.

dynamically configurable? (optional) is set to TRUE if item values such as
default rate can be dynamically configured when you launch the server. By
default, this input is FALSE.

error in (no error) describes the error status before this VI executes.

Table 3-1. Item Data Types

Item Data Type
String Actual Data Type Default Tag Type

DBL LabVIEW double (8-byte) IEEE float Analog

BLOB LabVIEW string or packed U8 array String

STR LabVIEW string or packed U8 array String

BOOL LabVIEW Boolean Discrete

I8 LabVIEW 8-bit signed integer Analog

I16 LabVIEW 16-bit signed integer Analog

I32 LabVIEW 32-bit signed integer Analog

U8 LabVIEW 8-bit unsigned integer Analog

U16 LabVIEW 16-bit unsigned integer Analog

U32 LabVIEW 32-bit unsigned integer Analog

SGL LabVIEW single (4-byte) float Analog

BITA Bit Array up to 32-bit integer Bit array
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access rights are the access directions supported by the item. If the item is
bi-directional, select I/O. Otherwise, select the input or output direction
appropriate for an item. The LabVIEW Datalogging and Supervisory
Control module uses this field to ensure that a tag is configured to access
the item in the directions supported by that item. For example, if an item is
registered as an input only item, the user can configure the item only as
input when the item is linked to a tag.

add max range is FALSE, by default, and no maximum range engineering
value is registered for the item. If you registered an item max range, set
this input to TRUE.

add min range is FALSE, by default, and no minimum range engineering
value is registered for the item. If you registered an item min range, set this
input to TRUE.

add unit is FALSE, by default, and engineering unit is registered for the
item. If you registered an item unit, set this input to TRUE.

error out describes the error status after this VI executes.
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SVRG Get Server Row VI
Returns the information registered for the server name from the Server table. Store this
information using the SVRG Add Server Row VI.

server name is the registered name of the server.

error in (no error) describes the error status before this VI executes.

configuration path is the path to the configuration utility for the server.
An empty path indicates no configuration utility.

server name returns the registered name of the server.

can add devices? specifies whether devices can be created for the server.

server type returns the type of the server. If it is a VI-based server, the
server type is VI.

launch path returns the path of the VI implementing the server, including
the VI name.

error out describes the error status after this VI executes.
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SVRG Get Device Row VI
Returns the information registered for the device name corresponding to server name.
Store this information using the SVRG Add Device Row VI.

server name is the registered name of the server.

device name is the name of a registered device for the server.

error in (no error) describes the error status before this VI executes.

device type returns a string documenting the type of device. The contents
of this string are server specific.

dynamically configurable? returns information on whether device values
can be dynamically configured when you launch the server.

can add items? returns information on whether items can be created for the
device.

default rate returns the default sampling period, in seconds, for polling
the item.

device address returns device address information stored for this device
by your server. The contents of this string are server specific.

error out describes the error status after this VI executes.
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SVRG Get Item Row VI
Returns information registered for item name corresponding to the server name and device
name. Store this information using the SVRG Add Item Row VI.

server name is the registered name of the server.

device name is the name of a registered device for the server.

item name is the name of a registered item for the device.

error in (no error) describes the error status before this VI executes.

max range? is TRUE if a maximum range was registered for this item.

min range? is TRUE if a minimum range was registered for this item.

unit? is TRUE if a unit was registered for this item.

max length? is TRUE if a maximum length was registered for this item.

item address returns item address information stored for this item.
The contents of this string are server specific.

item data type returns the data type stored for this item. Refer to Table 3-1,
Item Data Types, for more information on the stored data types.
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dynamically configurable? specifies whether this item can be
dynamically configured when you launch the server.

default rate returns the default sampling period, in seconds, for polling
the item.

access rights are the access directions supported by the item. I/O indicates
the item is bi-directional. Input indicates the item is input only. Output
indicates the item is output only.

error out describes the error status after this VI executes.

item max length is the maximum length associated with this item. If the
item data type = BITA, this number is interpreted to be the number of bits
associated with the item. If the item data type = STR or BLOB, the number
is interpreted to be the maximum length the string can be, in bytes. This
output is valid only if max length? is TRUE.

item unit is the engineering unit string for this item. This output is valid
only if unit? is TRUE.

item min range is the minimum value in engineering units for this item.
This output is valid only if min range? is TRUE.

item max range is the maximum value in engineering units for this item.
This output is valid only if max range? is TRUE.
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SVRG Delete Row VI
Deletes a specific row from the Server, Device, or Item tables. If you delete a server from the
Server table, all devices for the server in the Device table and all items for the server in the
Items table are deleted automatically. You do not have to delete devices and items individually
if you want to delete them all. Similarly, if a device is deleted from the Devices table, all items
for that device in the Items table are deleted automatically.

delete what (server) determines the table from which data is deleted.

server/proxy name is the name of the server for which the table row is
being deleted. Always enter a server name.

device name is the name of the device for which the table row is being
deleted.

item name is the name of the item for which the table row is being deleted.

error in (no error) describes the error status before this VI executes.

error out describes the error status after this VI executes.

2: Delete row from the Server table. This deletes all information
associated with the server from the Device and Item tables.

1: Delete row from the Device table. This deletes all information
associated with the device from the Device table.

0: Delete row from the Item table. This deletes all information
associated with the item from the Item table.
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SVRG Get Server Devices VI
Returns a list of devices registered for the server name.

server name is the unique name of the server as it should appear in the
Server list in the Tag Configuration Editor and other utilities.

error in (no error) describes the error status before this VI executes.

error out describes the error status after this VI executes.

no devices found is true if there are not devices registered for this server.

device names lists all the devices registered for the server.



Chapter 3 Function Reference — SVRG Get Server Items VI

© National Instruments Corporation 3-15 VI-Based Server Development Toolkit Reference Manual

SVRG Get Server Items VI
Returns a list of items registered for the server name and device name.

server name is the unique name of the server as it should appear in the
Server list in the Tag Configuration Editor and other utilities.

error in (no error) describes the error status before this VI executes.

device name is the name of the device as it should appear in the Devices
list in the Tag Configuration Editor and other utilities.

error out describes the error status after this VI executes.

no items found is true if there are no devices registered for this server.

item names lists all the items registered for the server and device.
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Server Interface VIs
The server also uses a set of subVIs to communicate with the Tag Engine
during server execution. These VIs are contained in the DSC Server
Interface palette.
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SRVR Get Item List VI
Returns lists of items, item characteristics, and item refnums that the Tag Engine requests
from a specific server.

server name is the registered name of the server.

item list is the specification for items that the server monitors and controls.
item list is an array of the SRVR item list.ctl Strict Type Definition.

device name is a string containing the name of the device. The
contents of this string are server specific. For example, you can
use the string to pass device address information to the server.
The user enters or selects this string from a list of preregistered
devices during tag configuration. The server must document valid
device name formats for the user or register a complete list of
devices.
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item name is a string containing the name of the item. The
contents of this string are server specific. For example, you might
use the string to pass item address information and formatting/
conversion information to the server. The user enters or selects this
string from a list of preregistered items during tag configuration.
The server must document valid item name formats for the user
or register a complete list of items available for each device
present.

BVE datatype is a Double or Binary Large Object (DBL or
BLOB) data type that the Tag Engine requests for the item. Items
passed to the Tag Engine must be coerced to this datatype.

item dir can be input, output, or I/O. If item dir is input, the
server must regularly poll the item. If item dir is output, the Tag
Engine only can control the item; that is, the item cannot be
monitored. If item dir is I/O, the server must regularly poll the
item, and the Tag Engine can control the item.

item datatype is a data type that the user expects to read from the
item. This is normally the default data type for that particular
device and item.

scan rate is the rate in seconds at which the server polls the item.
Use the closest rate available from your server. A rate of –1
indicates the use of the default or preconfigured server scan rate
for this item.

Note LabVIEW always passes –1: use default item datatype.

0: DBL—Indicates you must return a scalar value coerced to a
double data type.

1: BLOB—Indicates you must return data as a string or packed
U8 array. There is no internal format for this datatype.
LabVIEW treats it only as a byte stream.

0: input

1: output

2: I/O

–1: use default item datatype
0: use DBL item datatype
1: use BLOB item datatype
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notify on change, if TRUE, passes each new item value read from
the device to the Tag Engine only if it has changed (after server
start-up, the server must always return the initial item value).
If FALSE, notify on change returns every item value read from
the device, even if it has changed. If your server implements
% deadband, use the % deadband parameter in the group
corresponding to this item.

BVE refnum is a Tag Engine reference number that the server
must use when writing an item to the input queue or reading an
output item value from the output queue.

group name is the name of the group to which the user has
assigned this item. Obtain group parameters from the group list
output.

access path is the string for the access path corresponding to the
item. Access path is currently reserved for OPC servers only.

group list is the specification for groups of items that the server monitors
and controls. The user organizes all items into one or more groups during
tag configuration. Each group specifies timing and device information for
the item— in other words, all items in a group have the same timing
information and association with the same device. Most group information
is available from the item list output as well; therefore, this information is
redundant and can be ignored if the server does not specifically implement
deadbanding by percent on items. Because the group list presents common
information by group, this additional output is provided to a server as a
convenience. group list is an array of the SRVR group info.ctl Strict
Type Definition.
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group name is a string containing a user defined name for a
group of items. Each item in the item list has a corresponding
group name.

scan rate is the rate in seconds at which the server polls all items
in the group. Use the closest rate available from you server. If your
server cannot programmatically configure rates, choose the
default rate for your server. A rate of –1 indicates the use of the
default or preconfigured server scan rate for all items in this
group. Notice that this scan rate parameter is duplicated in the
item list array.

% deadband is the deadband in terms of percent of range that the
server applies to all items in the group before sending the item
values to the Tag Engine. A value of 0 indicates that no
deadbanding should be applied. Use the closest deadband percent
available from your server. If your server does not implement
deadbands, you can ignore this parameter; however, implement
the following cases:

• When % deadband is 0, return all acquired item values.

• When % deadband is > 0, return item values only if they
change.

This parameter is related to the notify on change parameter in the
item list array—notify on change is TRUE if % deadband is
greater than 0. If your server does not implement deadband by
percent of range, you can use the notify on change parameter in
the item list array instead.

device name is a string containing the name of the device used by
all items in the group. This parameter is duplicated in the item list
array.

error returns any errors that occurred: 0 indicates no error; –7202 specifies
an unrecognized server name.

shutdown is the notification to end server execution.

Note The same devices and items can occur for multiple refnums. Servers must handle
multiple connections to an item or write the unable to support multiple connections to
item status to the input queue for duplicate items.
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SRVR Write Input Queue VI
Writes input item and I/O item data to the Tag Engine. This VI also reports item status on
specific input, output, or I/O items. You can set this VI to return engine status.

block if queue full, by default, is TRUE. If TRUE, the SRVR write input
queue VI blocks if the input queue is full. This VI continues trying the
writes until successful. If FALSE, the server must handle the full input
queue. To handle the full input queue, compare the number actually written
with the number of queue entries the server attempted to write. If they are
not the same, retry with the unwritten entries, or the data is lost.

add timestamp to input values. Set this input if you have not time stamped
the values yourself. By default, this input is FALSE (left unwired), and
LabVIEW expects the values to have the correct timestamp already.

server name (optional) is the registered name of the server. If the return
status input is TRUE, only pass in server name. The server name
parameter is used to locate and return server status. Otherwise, input queue
data is passed to the Tag Engine without returning server shutdown or
changes pending status.

input queue data is an array of input item values to pass to the Tag Engine.
input queue data is an array of the SRVR input queue data.ctl

Strict Type Definition.
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BVE refnum is the reference number for an item returned by the
SRVR get item list VI.

datatype is the Double or Binary Large Object (DBL or BLOB)
data type being passed into the Tag Engine. datatype must
correspond to the data type specified in the item list. BLOB
signifies that binary data corresponding to this entry is passed into
the bin data input.

Note If status is bad for the item, the datatype parameter is ignored. Therefore, you do
not need to set the datatype parameter when reporting errors.

value is the item value when the item value is passed in as a
double-precision floating-point number. Scalar values might be
interpreted as analog, discrete (Boolean), or bit array (bit vectors
up to 32 bits in length), depending on the user tag configuration
for a specific device item. All scalar values must be converted
to double-floating points to pass to the Tag Engine. The server
must convert signed or unsigned values to double floating-point
numbers correctly. When the item value is passed in as a BLOB,
you must put the length in bytes (chars) of the bin data string
corresponding to this item in the value field.

timestamp is a double floating-point number set in seconds since
January 1, 1904 (Universal time). Use the Get Date/Time in
Seconds function to read this time into a VI. The server can
maintain and calculate its own timestamp as long as it
corresponds to the same seconds since 1904 used by the
LabVIEW Datalogging and Supervisory Control module.

status indicates the quality of the value passed to the server—
good, uncertain, or bad. See the Error Handling and the Status
Parameter section of Chapter 2, VI-Based Server Interface
to the Tag Engine, for more information on status.

bin data is binary or string data passed to the Tag Engine. If any of the input
types are set to BLOB, they are passed in the bin data input. All BLOBs
are treated as strings in LabVIEW and concatenated together to create a
single string to pass to the Tag Engine. For each input queue data element
writing binary data, the data type in the respective input queue data entry
is set to BLOB, and the value is set to the length of the string section.

return status, if set, enables the SRVR write input queue VI to use the
server name input to locate and return the server shutdown and changes
pending status.
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Note You must pass in the server name to get a valid indication of shutdown or changes
pending status. If you are not reading these outputs, you do not need to wire the server
name input.

# written indicates the number of input queue data entries successfully
passed to the Tag Engine. If this parameter is less than the length of the
input queue data array, an input queue full condition occurred, and the
server writes the remaining data at a later time.

error returns any errors that occurred: 0 indicates no error; –7201 indicates
write queue full (unable to complete write); –7202 specifies an
unrecognized server name.

shutdown is the notification to end server execution. shutdown is only a
valid output if server name is passed into the VI. If TRUE, the Tag Engine
is attempting to stop execution, and you must terminate your server
execution as soon as possible.

changes pending is only a valid output if server name is passed into the
VI. If TRUE, changes have been made to your server item list. Use the
SRVR Get Item List VI to receive an updated list, or call the SRVR Get
Item Changes VI to receive a list of changes to your item list. When the
server calls either of these VIs to get the most current item list information,
this flag is cleared.

Note The LabVIEW Datalogging and Supervisory Control module does not currently use
the changes pending parameter.



Chapter 3 Function Reference — SRVR Read Output Queue VI

VI-Based Server Development Toolkit Reference Manual 3-24 ni.com

SRVR Read Output Queue VI
Receives new output values for output or I/O items from the Tag Engine. This VI also returns
status information specifying whether the server is to shutdown or if item changes are
pending.

server name is the registered name of the server.

max # to read (0) is the maximum number of values to read from the output
queue. If you set max # to read to 0, this input reads all available values
for the server.

timeout (msecs) is the maximum timeout, in milliseconds, to wait before
reading the queue. The VI returns when data is available in the queue for
the server or timeout, depending on which occurs first. If the server status
changes because of shutdown notification or item list changes for the
server, this VI returns immediately. If timeout (msec) = 0, the VI returns
immediately. If timeout (msec) = –1, the VI waits until data is available in
the queue for the server or the server status changes to return. Use a fairly
long timeout, at least 1 second, to prevent unnecessary looping or use –1 to
return only if an event occurs.

output queue data is an array of output item values the server writes out
to the items. output queue data is an array of the SRVR output queue
data.ctl Strict Type Definition.
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BVE refnum is the reference number for an item returned by the
SRVR Get Item List VI.

datatype is the Double or Binary Large Object (DBL or BLOB)
data type returned by the Tag Engine. datatype corresponds to the
data type specified in the item list. BLOB signifies that binary
data corresponding to this entry is returned in the bin data out
output.

value is normally a double floating-point number that the Tag
Engine wants written to the output item. If the datatype is a
BLOB, binary data is returned in the bin data out output, and
value signifies the length of the binary string in the bin data out
output corresponding to this entry.

bin data out is binary or string data returned by the Tag Engine. If any of
the output types are BLOB, they are passed to the bin data out output. All
BLOBs are treated as strings in the LabVIEW Datalogging and
Supervisory Control module and concatenated into a single string returned
by this VI. The datatype in the respective output queue data entry is then
set to BLOB, and value is set to the length of the string for that entry.

number read indicates the number of output queue data entries that have
been read from the Tag Engine.

error returns any errors that occurred: 0 indicates no error; –7202 specifies
an unrecognized server name.

shutdown is the notification to end server execution.

changes pending indicates that changes have been made to your server
item list. Use the SRVR Get Item List VI to receive an updated list or call
the SRVR Get Item Changes VI to receive a list of changes to your item
list. When the server calls either of these VIs to get the latest item list
information, this flag is cleared.

Note The LabVIEW Datalogging and Supervisory Control module does not currently use
the changes pending parameter.
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SRVR Post Message VI
Writes error messages from the server to the Tag Engine where the messages can be logged
and displayed to the user. See Error Handling and the Status Parameter, in Chapter 2,
VI-Based Server Interface to the Tag Engine, for more information about when to use this VI.

item name (opt) is the name of the item that caused the error.

device name (opt) is the name of the device that caused the error.

server name is the registered name of the server reporting the error.

message is an ASCII string error message.

timestamp is the timestamp indicating when the error occurred or when it
was reported.

status (opt) is the status associated with the error.

Message Type (Error=F) is the type of message. If FALSE, the message is
an error message. If TRUE, the message is not an error but a server event of
interest. By default, Message Type is set to FALSE to indicate an error
message.

error returns any errors that occurred: 0 indicates no error; –7202 specifies
an unrecognized server name.
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SRVR Get Status VI
Polls the Tag Engine for the current server status.

server name is the registered name of the server.

shutdown is the notification to end server execution.

changes pending indicates that changes have been made to your server
item list. Use the SRVR Get Item List VI to receive an updated list or call
the SRVR Get Item Changes VI to receive a list of changes to your item
list. When the server calls either of these VIs to get the latest item list
information, this flag is cleared.

error returns any errors that occurred: 0 indicates no error; –7202 specifies
an unrecognized server name.

Note The LabVIEW Datalogging and Supervisory Control module currently does not use
the changes pending parameter.
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SRVR Get Item Changes VI
Returns a list of item changes.

server name is the registered name of the server.

changed group list is a list of groups that have been changed in one or
more attributes since the last item update. For parameter definitions, see the
following group spec figure.

new group list is a list of groups that have been added for the server to
monitor since the last item update. For parameter definitions, see the
following group spec figure.

The new group list, changed group list, and obsolete group list are all
arrays of the SRVR group info.ctl Strict Type Definition.

group name is a string containing a user defined name for a
group of items. Each item in the item list has a corresponding
group name.
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scan rate is the rate in seconds at which the server polls all items
in the group. Use the closest rate available from you server. If your
server cannot programmatically configure rates, choose the
default rate for your server. A rate of –1 indicates the use of the
default or preconfigured server scan rate for all items in this
group. Notice that this scan rate parameter is duplicated in the
item list array.

% deadband is the deadband in terms of percent of range that the
server applies to all items in the group before sending the item
values to the Tag Engine. A value of 0 indicates that no
deadbanding should be applied. Use the closest deadband percent
available from your server. If your server does not implement
deadbands, you can ignore this parameter; however, implement
the following cases:

• When % deadband is 0, return all acquired item values.

• When % deadband is > 0, return item values only if they
change.

This parameter is related to the notify on change parameter in the
item list array—notify on change is TRUE if % deadband is
greater than 0. If your server does not implement deadband by
percent of range, you can use the notify on change parameter in
the item list array instead.

device name is a string containing the name of the device used by
all items in the group. This parameter is duplicated in the item list
array.

new item list is a list of items that have been added for the server to monitor
since the last item update. For parameter definitions, see the following item
spec figure.

changed item list is a list of items that have been changed in one or more
attributes since the last item update. For parameter definitions, see the
following item spec figure.

obsolete item list is a list of items that the Tag Engine no longer wants to
monitor. Only the device name, item name, and BVE refnum elements of
this list are valid. The server should no longer pass any item values to the
server corresponding to these BVE refnums. For parameter definitions, see
the following item spec figure.
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The new item list, changed item list, and obsolete item list are all arrays
of the SRVR item list.ctl Strict Type Definition.

device name is a string containing the name of the device. The
contents of this string are server specific. For example, you can
use the string to pass device address information to the server.
The user enters or selects this string from a list of preregistered
devices during tag configuration. The server must document valid
device name formats for the user or register a complete list of
devices.

item name is a string containing the name of the item. The
contents of this string are server specific. For example, you might
use the string to pass item address information and formatting/
conversion information to the server. The user enters or selects
this string from a list of preregistered items during tag
configuration. The server must document valid item name
formats for the user or register a complete list of items available
for each device present.
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BVE datatype is a Double or Binary Large Object (DBL or
BLOB) data type that the Tag Engine requests for the item. Items
passed to the Tag Engine must be coerced to this datatype.

item dir can be input, output, or I/O. If item dir is input, the
server must regularly poll the item. If item dir is output, the Tag
Engine only can control the item; that is, the item cannot be
monitored. If item dir is I/O, the server must regularly poll the
item, and the Tag Engine can control the item.

item datatype is a data type that the user expects to read from the
item. This is normally the default data type for that particular
device and item.

Note LabVIEW always passes –1: use default item datatype.

scan rate is the rate in seconds at which the server polls the item.
Use the closest rate available from your server. A rate of –1
indicates the use of the default or preconfigured server scan rate
for this item.

notify on change, if TRUE, passes each new item value read from
the device to the Tag Engine only if it has changed (after server
start-up, the server must always return the initial item value). If
FALSE, notify on change returns every item value read from the
device, even if it has changed. If your server implements
% deadband, use the % deadband parameter in the group
corresponding to this item.

0: DBL—Indicates you must return a scalar value coerced to a
double data type.

1: BLOB—Indicates you must return data as a string or packed
U8 array.

0: input

1: output

2: I/O

–1: use default item datatype
0: use DBL item datatype
1: use BLOB item datatype
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BVE refnum is a Tag Engine reference number that the server
must use when writing an item to the input queue or reading an
output item value from the output queue.

group name is the name of the group to which the user has
assigned this item. Obtain group parameters from the group list
output.

access path is the string for the access path corresponding to the
item. Access path is currently reserved for OPC servers only.

error returns any errors that occurred: 0 indicates no error; –7202 specifies
an unrecognized server name.

shutdown is the notification to end server execution.

obsolete group list is a list of groups that the Tag Engine no longer wants
to monitor. For parameter definitions, see the preceding group spec figure
and definition.
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A
Technical Support Resources

Web Support
National Instruments Web support is your first stop for help in solving
installation, configuration, and application problems and questions. Online
problem-solving and diagnostic resources include frequently asked
questions, knowledge bases, product-specific troubleshooting wizards,
manuals, drivers, software updates, and more. Web support is available
through the Technical Support section of ni.com

NI Developer Zone
The NI Developer Zone at zone.ni.com is the essential resource for
building measurement and automation systems. At the NI Developer Zone,
you can easily access the latest example programs, system configurators,
tutorials, technical news, as well as a community of developers ready to
share their own techniques.

Customer Education
National Instruments provides a number of alternatives to satisfy your
training needs, from self-paced tutorials, videos, and interactive CDs to
instructor-led hands-on courses at locations around the world. Visit the
Customer Education section of ni.com for online course schedules,
syllabi, training centers, and class registration.

System Integration
If you have time constraints, limited in-house technical resources, or other
dilemmas, you may prefer to employ consulting or system integration
services. You can rely on the expertise available through our worldwide
network of Alliance Program members. To find out more about our
Alliance system integration solutions, visit the System Integration section
of ni.com
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Worldwide Support
National Instruments has offices located around the world to help address
your support needs. You can access our branch office Web sites from the
Worldwide Offices section of ni.com. Branch office web sites provide
up-to-date contact information, support phone numbers, e-mail addresses,
and current events.

If you have searched the technical support resources on our Web site and
still cannot find the answers you need, contact your local office or National
Instruments corporate. Phone numbers for our worldwide offices are listed
at the front of this manual.



© National Instruments Corporation G-1 VI-Based Server Development Toolkit Reference Manual

Glossary

Prefix Meanings Value

p- pico- 10–12

n- nano- 10–9

µ- micro- 10– 6

m- milli- 10–3

k- kilo- 103

M- mega- 106

G- giga- 109

t- tera- 1012

Numbers/Symbols

° degrees

% percent

Hz Hertz

sec seconds

A

A/D Analog-to-digital.

abort The procedure that terminates a program when a mistake, malfunction, or
error occurs.

address Character code that identifies a specific location (or series of locations) in
memory or on a communications network or device.
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alarm An abnormal process condition. In the LabVIEW Datalogging and
Supervisory Control module, an alarm occurs if a tag value goes out of its
defined alarm limits or if a tag has bad status.

analog tag A continuous value representation of a connection to a real-world I/O point
or memory variable. This type of tag can vary continuously over a range of
values within a signal range.

array An ordered, indexed set of data elements of the same type.

ASCII American Standard Code for Information Interchange.

B

bit Binary digit. The smallest possible unit of data: a two-state, yes/no,
0/1 alternative. The building block of binary coding and numbering
systems. Several bits make up a byte.

bit array tag A multibit value representation of a connection to a real-world I/O point or
memory variable. In the LabVIEW Datalogging and Supervisory Control
module, this type of tag can be comprised of up to 32 discrete values.

bit vector A string of related bits in which each bit has a specific meaning.

block diagram Pictorial description or representation of a program or algorithm. In the
LabVIEW Datalogging and Supervisory Control module, the block
diagram, which consists of executable icons called nodes and wires that
carry data between the nodes, is the source code for the virtual instrument.
The block diagram resides in the Diagram window of the VI.

Boolean controls and
indicators

Front panel objects used to manipulate and display or input and output
Boolean (TRUE or FALSE) data. Several styles are available, such as
switches, buttons, and LEDs.

broken VI VI that cannot be complied or run; signified by a broken arrow in the Run
button.

buffer Temporary storage for acquired or generated data.

byte A grouping of adjacent binary digits (bits) operated on by the computer as
a single unit.



Glossary

© National Instruments Corporation G-3 VI-Based Server Development Toolkit Reference Manual

C

Case structure Conditional branching control structure, which executes one and only one
of its subdiagrams based on its input. It is the combination of the
If-Then-Else and Case statements in control flow languages.

CCDB Common Configuration Database. Manages the registered server
information by maintaining tables of servers, devices, and items.

channel Pin or wire lead to which you apply or from which you read the analog or
digital signal.

cluster A set of ordered, unindexed data elements of any data type including
numeric, Boolean, string, array, or cluster. The elements must be all
controls or all indicators.

Code Interface Node
(CIN)

Special block diagram node through which you can link conventional,
text-based code to a VI.

command A directive to a device.

connector Part of the VI or function node that contains its input and output terminals,
through which data passes to and from the node.

control Front panel object for entering data to a VI interactively or to a subVI
programmatically.

CPU Central processing unit.

D

data acquisition Process of acquiring data, typically from A/D or digital input plug-in
boards.

datatype descriptor Code that identifies datatypes, used in data storage and representation.

DDE Dynamic Data Exchange. A client-controlled Windows protocol for
communication between applications.

device An instrument or controller that is addressable as a single entity and
controls or monitors real-world I/O points. A device is often connected to
the host computer through some type of communication network, or it can
be a plug-in device.
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device server An application that communicates with and manages a peripheral hardware
device such as a Programmable Logic Control (PLC), remote I/O device, or
plug-in device. Device servers pass item values to the Tag Engine in real
time.

diagram window A VI window that contains the VI block diagram code.

dialog box An interactive screen with prompts in which the user specifies additional
information needed to complete a command.

discrete tag A two-state (on/off) value representation of a connection to a real-world I/O
point. In the LabVIEW Datalogging and Supervisory Control module, this
type of tag can be either a one (TRUE) or a zero (FALSE).

DLL Dynamic link library.

E

Engine See Tag Engine.

engineering units (EU) Terms of data measurement, as degrees Celsius, pounds, grams, and so on.

error message An indication of a software or hardware malfunction or an unacceptable
data entry attempt.

event Something that happens to a tag in the LabVIEW Datalogging and
Supervisory Control module system. Events include tags going into or out
of alarm state and the user setting a tag value.

event-driven
programming

A method of programming whereby the program waits on an event
occurring before executing one or more functions.

executable A stand-alone piece of code that runs or executes.

F

FIFO First-In-First-Out. A method of data storage in which the first element
stored is the first one retrieved.

For Loop Iterative loop structure that executes its subdiagram a set number of times.
Equivalent to conventional code:
For i = 0 to n–1, do ....
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front panel The interactive user interface of a VI. Modeled from the front panel of
physical instruments, it is composed of switches, slides, meters, graphs,
charts, gauges, LEDs, and other controls and indicators.

function Built-in execution element comparable to an operator, function, or
statement in a conventional language.

G

G Graphical programming language used to develop LabVIEW applications.

group Collection of items associated with the same server and device that share
timing configuration.

H

Human Machine
Interface (HMI)

A graphical user interface for the user to interact with the LabVIEW
system. Also known as MMI.

Hz Hertz. The number of scans read or updates written per second.

I

I/O Input/output. The transfer of data to or from a computer system involving
communications channels, operator interface devices, and/or data
acquisition and control interfaces.

icon Graphical representation of a node on a block diagram.

IEEE Institute of Electrical and Electronic Engineers.

indicator Front panel object that displays output.

Input/Output (I/O) tag A tag that accepts Real-Time Database values from a device server and
sends values to the server.

item A channel or variable in a real-world device that is monitored or controlled
by a device server.

iteration terminal The terminal of a For Loop or While Loop that contains the current number
of completed iterations.
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L

LabVIEW Laboratory Virtual Instrument Engineering Workbench. A graphical
program development application used commonly for test and
measurement and industrial automation.

LED Light-emitting diode.

LSW Least Significant Word.

M

Man Machine Interface
(MMI)

See Human Machine Interface (HMI).

MB Megabytes of memory.

MSW Most Significant Word.

multitasking The ability of a computer to perform two or more functions simultaneously
without interference from one another. In operating system terms, it is the
ability of the operating system to execute multiple applications/processes
by time-sharing the available CPU resources.

N

nodes Execution elements of a block diagram consisting of functions, structures,
and subVIs.

O

object Generic term for any item on the front panel or block diagram, including
controls, nodes, wires, and imported pictures.

OLE Object Linking and Embedding.

OLE Automation A feature that allows the LabVIEW Datalogging and Supervisory Control
module to access objects by automation servers in the system.
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OPC OLE for Process Control, and industry standard interface to share data
between applications.

operator The person who initiates and monitors the operation of a process.

P

palette A display of pictures that represent possible options.

Panel window VI window that contains the front panel, the execution palette, and the
icon/connector pane.

path Description of the location of a file or directory, including the volume
containing the file or directory, the directories between the top level and the
file or directory, and the file or directory name.

polling A method of sequentially observing each I/O point or user interface control
to determine if it is ready to receive data or request computer action.

Programmable Logic
Control (PLC)

A device with multiple inputs and outputs that contains a program you can
alter. Device Servers establish communication with PLCs.

Q

query Like a command, causes a device to take some action but requires a
response containing data or other information. A command does not
require a response.

queue A group of items waiting to be acted on by the computer. The arrangement
of the items determines their processing priority. Queues usually are
accessed in a FIFO fashion.

R

RAM Random access memory.

range The region between the limits within which a quantity is measured,
received, or transmitted expressed by stating the lower and upper range
values.

read To get information from any input device or file storage media.
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Real-Time Database
(RTDB)

An in-memory snapshot of all tags in the system.

refnum An identifier used to refer to specific data or structures, such as files, tags
or server items.

register A high-speed device used in a CPU for temporary storage of small amounts
of data or intermediate results during processing.

S

sampling period The time interval between observations in a periodic sampling control
system.

scalar Number capable of being represented by a point on a scale. A single value
as opposed to an array. Scalar Booleans, strings, and clusters are explicitly
singular instances of their respective data types.

scan rate The number of times (or scans) per second that a device acquires data from
channels. For example, at a scan rate of 10Hz, a device samples each
channel in a group 10 times per second.

Sequence structure Program control structure that executes its subdiagrams in numeric order.
Commonly used to force nodes that are not data dependent to execute in a
desired order.

server The application that receives messages and requests from the client
application.

signed integer n bit pattern, interpreted such that the range is from –2(n – 1) to
+2(n – 1) – 1.

string A connected sequence of characters or bits treated as a single data item.

string data A packed array of unsigned 8-bit integers.

string tag A string representation of a connection to a real-world I/O point.

structure Program control element, such as a Sequence, Case, For Loop, or
While Loop.

subdiagram Block diagram within the border of a structure.

subVI A VI used in the block diagram of another VI.



Glossary

© National Instruments Corporation G-9 VI-Based Server Development Toolkit Reference Manual

system errors Errors that happen in the LabVIEW Datalogging and Supervisory Control
module system, like a server going down. System errors are displayed in a
dialog box on the Engine User Interface and logged in a syslog file.

system events Events that occur in the LabVIEW Datalogging and Supervisory Control
module system, like an operator logging on or a utility starting up. System
events are logged in a syslog file.

T

tag A connection to a real-world I/O point or a memory variable. Tags can be
one of four datatypes: analog, binary, discrete, or string.

tag attributes Parameters pertaining to a tag, like its alarm, limits, or Engineering Units.
Tag attributes are configured in the Tag Configuration Editor but can be
changed dynamically using the Tag Attributes VIs.

Tag Browser A utility to view the configuration parameters of a tag, as configured in the
Tag Configuration Editor.

Tag Configuration
Editor

A utility to configure various parameters of a tag, such as connection
information, scaling, or logging.

Tag Engine The heart of the LabVIEW Datalogging and Supervisory Control module
system. It maintains the Real-Time Database of all tag values and alarm
states. The Tag Engine runs as a separate process, independent of your HMI
application.

Tag Monitor A utility to view the current value of a tag, along with its status and alarm
state.

tag status A variable that determines the validity of a tag value. A negative status
represents an error, a positive status represents a warning, and a status of
zero represents a good tag value.

timeout The time (in milliseconds) that a VI waits for an operation to complete.
Generally, a timeout of –1 causes a VI to wait indefinitely.

timestamp The exact time and date at which a tag value was sampled. Tag values are
stored with their timestamps in the RTDB.

toolbar Bar containing command buttons that you can use to run and debug VIs.
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U

unsigned integer n bit pattern interpreted such that the range is from 0 to 2n – 1.

user See operator.

utility A program that helps the user run, enhance, create, or analyze other
programs and systems.

V

VI Library Special file that contains a collection of related VIs for a specific use.

virtual instrument (VI) A program in the graphical programming language G; so-called because it
models the appearance and function of a physical instrument.

W

While Loop Post-iterative test loop structure that repeats a section of code until a
condition is met. Comparable to a Do loop or a Repeat-Until loop in
conventional programming languages.

wire Data path between nodes.
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